
 
 
 
 
 
 
 
 
 

IBM Rational Synergy for  

Microsoft Visual Studio 2010 Interface 

7.2.1 

 



Before using this information, be sure to read the general information under Notices. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This edition applies to IBM Rational Synergy for Microsoft Visual Studio 2010 
Interface 7.2.1 and to all subsequent releases and modifications until otherwise 
indicated in new editions. 

IBM Rational Synergy for Microsoft Visual Studio 2010 Interface7.2.1 Page 2 of 53 



 
Table of Contents 
 
About the Integration ............................................................................................................. 6 

Assumptions ......................................................................................................................... 6 

Features............................................................................................................................... 6 

How the integration works ...................................................................................................... 6 

Audience .............................................................................................................................. 7 

What’s new........................................................................................................................... 7 

Requirements........................................................................................................................ 7 

Installation ........................................................................................................................... 7 

Installing Rational Synergy .................................................................................................. 7 

Installing the integration ..................................................................................................... 8 

Before using the integration .................................................................................................... 8 

Setting up the database ...................................................................................................... 9 

Setting up the work area..................................................................................................... 9 

Installing Visual Studio file types and ignore rules..................................................................10 

Selecting the source control plug-in .....................................................................................10 

Activating the IBM Rational Synergy Taskbar.........................................................................10 

Activating the IBM Rational Synergy output console window ....................................................11 

Activating the IBM Rational Synergy Task View......................................................................11 

Activating the IBM Rational Synergy Change Request view ......................................................12 

Project setup and migration....................................................................................................13 

Project mapping................................................................................................................13 

How to migrate.................................................................................................................14 

Building your application in Visual Studio ..............................................................................14 

Migrating to Rational Synergy .............................................................................................14 

Migrating from within Microsoft Visual Studio ........................................................................14 

Rebuilding and baselining your project .................................................................................17 

Setting up a development project............................................................................................18 

Copying a project ..............................................................................................................19 

Opening a project from the file system.................................................................................20 

Getting familiar with the integration ........................................................................................20 

IBM Rational Synergy Taskbar.............................................................................................21 

Creating a task..............................................................................................................21 

Completing a task..........................................................................................................21 

Showing task properties .................................................................................................22 

Selecting a task.............................................................................................................22 

Opening a project ..........................................................................................................22 

Showing the Rational Synergy interface ............................................................................22 

IBM Rational Synergy for Microsoft Visual Studio 2010 Interface7.2.1 Page 3 of 53 



Task box ......................................................................................................................23 

Working offline..............................................................................................................24 

Switching back to Online Mode ........................................................................................26 

IBM Rational Synergy Output Console window...........................................................................27 

IBM Rational Synergy views ...................................................................................................27 

IBM Rational Synergy Task view..........................................................................................27 

IBM Rational Synergy Change Request view..........................................................................29 

Toolbar operations ............................................................................................................31 

Refresh view.................................................................................................................31 

Add Saved Task query....................................................................................................32 

Add Saved Change Request query....................................................................................32 

Pop-up menu operations ....................................................................................................32 

Cutting a query .............................................................................................................33 

Refreshing a query ........................................................................................................33 

Viewing change request properties ...................................................................................33 

Viewing task properties ..................................................................................................33 

Completing a task..........................................................................................................33 

Viewing object properties................................................................................................34 

Symbols ..........................................................................................................................34 

Tooltips ...........................................................................................................................34 

Settings ..............................................................................................................................34 

Connection management....................................................................................................35 

Connection Management menu........................................................................................35 

General settings................................................................................................................36 

Rational Synergy 'smart-card' login feature...........................................................................38 

Daily development ................................................................................................................38 

Using task-based CM .........................................................................................................39 

Connecting a solution or project ..........................................................................................40 

Migrating projects .............................................................................................................40 

Adding new files and folders to databases.............................................................................41 

Removing files from databases............................................................................................42 

Synchronizing a work area..................................................................................................43 

Checking out files..............................................................................................................43 

Undoing a check out ..........................................................................................................44 

Checking in files................................................................................................................45 

Comparing a file or folder with its predecessor ......................................................................45 

Viewing the history of objects .............................................................................................45 

Viewing or modifying properties of objects ............................................................................46 

Using a version of a file or folder .........................................................................................46 

IBM Rational Synergy for Microsoft Visual Studio 2010 Interface7.2.1 Page 4 of 53 



Updating members ............................................................................................................46 

Refreshing the version control status ...................................................................................47 

Disconnecting a solution or project ......................................................................................47 

Debugging support................................................................................................................47 

Changing the Debug Level value..........................................................................................48 

Viewing the error log .........................................................................................................48 

Issues with this release .........................................................................................................49 

Contacting IBM Rational Software Support................................................................................50 

Notices................................................................................................................................50 

Copyright license ..............................................................................................................52 

Privacy policy considerations...............................................................................................52 

Trademark acknowledgments..............................................................................................53 

 
 

IBM Rational Synergy for Microsoft Visual Studio 2010 Interface7.2.1 Page 5 of 53 



 

About the Integration 
The IBM Rational® Synergy™ for Microsoft® Visual Studio Interface™ gives you change 
management (CM) support through insulated and build management work areas, provides 
task-based CM support, and supports source code control operations on project files directly 
from Microsoft Visual Studio 2010. This integration lets you control and set up your Visual 
Studio 2010 projects in Rational Synergy. This integration is provided in the form of an 
install program which can be downloaded from the IBM Rational website. 

Assumptions 
Before using this document, you should have a basic understanding of how to use the 
Microsoft Visual Studio 2010 IDE and Rational Synergy. If you are unfamiliar with Visual 
Studio 2010, complete the tutorial and read the online help for Visual Studio 2010. 

For information about Microsoft Visual Studio 2010, see the MSDN Library for Visual Studio 
2008. 

You should also have a conceptual and practical understanding of Rational Synergy. You 
should understand task-based CM and be able to perform developer or build manager 
operations. 

 For information about Rational Synergy, see the Rational Synergy information center 
at: http://pic.dhe.ibm.com/infocenter/rsdp/v1r0m0/index.jsp. 

 For terms, concepts, and methodology, see 
http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.p
rodoverview.doc/topics/s_r_int_synergy_terminology.html. 

 For information about build management-level operations, see the Build Manager's 
section in the Rational Synergy information center 
(http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.
manage.doc/topics/s_c_bmg_auto_builds_4ratlsyn.html). 

 For a description of Rational Synergy dialog boxes, commands, and default settings, 
see the Rational Synergy information center. 

Read this entire document before using the integration. Knowing all of the features before 
you integrate your data will help ensure a seamless, efficient integration. 

Features 
This integration lets you use the source code control and task-based CM operations from the 
Visual Studio 2010 development IDE. You can configure the integration to use multiple 
Rational Synergy databases. 

How the integration works 
This integration has been completely rewritten for Microsoft Visual Studio 2010. Therefore, 
it has significant changes from the previous Microsoft Visual Studio 2003 integration 
(version 2.3). 

The integration can connect to multiple Rational Synergy databases using Rational Synergy 
Connections. A Rational Synergy Connection uniquely represents a Rational Synergy 
database. When you start a Rational Synergy Connection, a corresponding Rational Synergy 

IBM Rational Synergy for Microsoft Visual Studio 2010 Interface7.2.1 Page 6 of 53 

http://pic.dhe.ibm.com/infocenter/rsdp/v1r0m0/index.jsp
http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.prodoverview.doc/topics/s_r_int_synergy_terminology.html
http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.prodoverview.doc/topics/s_r_int_synergy_terminology.html
http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.manage.doc/topics/s_c_bmg_auto_builds_4ratlsyn.html
http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.manage.doc/topics/s_c_bmg_auto_builds_4ratlsyn.html


session is started. A Rational Synergy Connection is required by the integration to be able to 
connect to the Rational Synergy database. 

You must customize your Microsoft Visual Studio 2010 IDE to see the Rational Synergy Task 
menu and Rational Synergy Task toolbar. You also need to open the Rational Synergy 
output Console Window to view the messages returned by the integration. 

Audience 
The audience for this document is developers. The information in the Rational Synergy for 
Microsoft Visual Studio Interface Help assumes that you have a basic understanding of how 
to use Microsoft Visual Studio 2010 and the Rational Synergy client. Information about 
Rational Synergy in this document is limited to what is essential for you to know to use the 
integration. 

What’s new 
Rational Synergy for Microsoft Visual Studio Interface offers the following new features: 

This integration is based on Visual Studio Industry Partners program. It is written as a 
Visual Studio Package. 

This version of the integration only works with Rational Synergy 7.2.1. Rational Synergy 
Classic client or older versions of Rational Synergy are not supported by this integration. 

Rational Synergy 7.2.1 has a limitation with multiple simultaneous connections. See Issues 
with this Release for more details. 

This version of the integration will only work with Microsoft Visual Studio 2010. However, it 
can co-exist with the Visual Studio 2003 Integration, Release 2.4, IBM Rational Synergy for 
Microsoft Visual Studio 2005 Interface 7.2, and IBM Rational Synergy for Microsoft Visual 
Studio 2008 Interface 7.2. 

Requirements 
The following products are required to run Rational Synergy for Microsoft Visual Studio 
Interface: 

 Microsoft® Windows 7, 2003 or 2008. 

 Microsoft Visual Studio 2010 on supported platforms. 

 Rational Synergy 7.2.1 on supported platforms 

 Rational® Change™ 5.3.1 (Optional) 

 Rational® Team Concert 4.0.3 (Optional) 

Installation 
Before you install the integration, Rational Synergy Release 7.2.1 and Microsoft Visual 
Studio 2010 must be installed. The information below provides some instructions on how to 
install Rational Synergy. 

Installing Rational Synergy 
See the installation instructions for Rational Synergy in the Rational Synergy Installation 
Guide for Windows 
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(http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.install.
win.doc/topics/sg_c_igw_install_on_win.html). 

After you have properly installed Rational Synergy and Microsoft Visual Studio 2010, you 
are ready to install IBM Rational Synergy for Microsoft Visual Studio Interface. To learn how 
to install the integration, see Install the Integration. 

Installing the integration 

Before you install IBM Rational Synergy for Microsoft Visual Studio Interface, ensure that 
you have done the following: 

 Install Rational Synergy Release 7.2.1 and Microsoft Visual Studio 2010. 

 Uninstall any previous versions of Rational Synergy for Microsoft Visual Studio 
Interface. 

 Uninstall any previous versions of IBM Rational Synergy for Microsoft Visual Studio 
Interface Help.  To do this, go to Control Panel > Add or remove Programs and 
remove the IBM Rational Synergy for Microsoft Visual Studio Interface Help program. 

 Stop all Rational Synergy sessions. 

 Read the Team Development and Source Control Operation documentation provided 
by Microsoft. 

 Set your Rational Synergy database or databases to case=PRESERVE. 

Carefully follow the steps below to install IBM Rational Synergy for Microsoft Visual Studio 
Interface: 

1. Copy Rational Synergy for Microsoft Visual Studio 2010 Interface 7.2.1 from the 
Rational Synergy 7.2.1 integration CCM_HOME\integrations\vs2010 location. 

2. Navigate to setup.exe and run the setup.  
 
The setup wizard will guide you through the installation steps. 

3. After installing the integration, start Microsoft Visual Studio 2010. 

Before using the integration 

After you have successfully installed the integration, you must perform additional set-up 
and installation activities before you can begin using the integration. You need to customize 
Microsoft Visual Studio 2010 to view the Rational Synergy toolbar and menu as well as other 
views offered by the integration. 

You must read the latest Readme to view the most current information. 

 Setting up the database 

 Setting up the work area 

 Installing Visual Studio file types and ignore rules 

 Selecting the source control plug-in 

 Activating the IBM Rational Synergy Taskbar 

 Activating the IBM Rational Synergy Output Console window 

 Activating the IBM Rational Synergy Task view 
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 Activating the IBM Rational Synergy Change Request view 

Setting up the database 
Before you can properly begin using the integration, it is important that you set up your 
Rational Synergy database. There are two important set-up activities to perform on your 
Rational Synergy database. 

1. Ensure that your Rational Synergy database is set to Preserve case: 

a. Open up a command prompt on the Rational Synergy server machine 
and ensure that ccmdb is in your path. 

b. Type the following command: 
 
ccmdb info <dbpath> /k case /v PRESERVE. 

c. Exit the command prompt. 

d. Restart the machine. 

2. Ensure that your Rational Synergy database is set to support multiple project 
instances. This is required to support the creation of Solution projects having 
the same name as the Solution. 

a. Start a Rational Synergy session. 

b. Select Tools > Start Synergy CLI. 

c. Ensure that ccm is in your path. 

d. Type the following commands: 
 
ccm set role ccm_admin 
 
ccm query -t model -n base 
 
ccm attr -m multiple_local_proj_instances -v TRUE @1 

e. Exit the Rational Synergy CLI. 

Setting up the work area 

Before you begin using the integration to perform source code control operations, you must 
set Rational Synergy to use a work area template that does not contain project or database 
specific information. Follow the steps provided below to properly set your work area 
template. 

1. Start a Rational Synergy session. 

2. Click Tools and select Options. 

3. Click the Actions tab and select Copy Project from the list provided. 

4. Ensure that the + Database name and the Add project-specific directory 
options are not selected. 

5. Click Apply to save your changes, then click OK to exit the Options dialog 
box. 

Note: You need this work area template only for project migration. It is not required to 
have this work area template for the Copy Project operation. 
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Installing Visual Studio file types and ignore rules 

Microsoft Visual Studio file types and ignore rules must be installed into each Rational 
Synergy database before you can use the integration. To install these types, your group 
membership must include ccm_admin privileges. 

1. Start a Rational Synergy session. 

2. Select Tools > Start Synergy CLI. 

3. From the command prompt, load the Visual Studio file types program by 
running <Rational Synergy Install 
Directory>\etc\mstypes_vs2010.bat. 
 
This program installs different file types for Microsoft Visual Studio 2010. 

4. After the installation is complete, exit and restart your Rational Synergy 
session. 

Selecting the source control plug-in 

Before you can use any of the task-based and source code control operations that Rational 
Synergy for Microsoft Visual Studio Interface offers, you must first select Rational Synergy 
as your source control plug-in selection. 

1. Open the Microsoft Visual Studio 2010 IDE. 

2. In the Microsoft Visual Studio 2010 main menu, click Tools, then select 
Options. 

3. Select Source Control, then select the Plug-in Selection option.  
 
The Options dialog box opens so that you can choose your current source 
control plug-in. You must select IBM Rational Synergy. 

4. Select IBM Rational Synergy and click OK. 

Once you have selected IBM Rational Synergy as your current source control plug-in, the 
Rational Synergy Settings dialog box may open if you have no Rational Synergy connections 
available.  You must create a Rational Synergy connection in order to perform the source 
control operations offered by the integration. For more information about creating a 
connection, see Connection management. 

Activating the IBM Rational Synergy Taskbar 

To use the IBM Rational Synergy Taskbar that is made available to you in the integration, 
you must first activate it. 

1. In the Microsoft Visual Studio 2010 IDE, click Tools, then select Customize. 

2. Select the IBM Rational Synergy Taskbar option, then click Close. 

There is alterative way to activate the IBM Rational Synergy Taskbar. In the Microsoft Visual 
Studio IDE, right click on any available space around the toolbars. You will see several menu 
options. 

Select IBM Rational Synergy Taskbar. The IBM Rational Synergy Taskbar is available as an 
additional toolbar in the Microsoft Visual Studio IDE. 
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Activating the IBM Rational Synergy output console window 

To view any messages that result from performing any of the version control operations, 
you must activate the IBM Rational Synergy Output console window. 

1. In the Microsoft Visual Studio 2010 IDE, click View, then select Output. 

2. The Output console window opens at the bottom of the Microsoft Visual Studio 
2010 IDE. You can view the messages that result from any source control 
operations that you perform. 

Activating the IBM Rational Synergy Task View 

The Rational Synergy Task View is activated automatically and added to the Microsoft Visual 
Studio 2010 IDE once you select Rational Synergy as your source control plug-in. For more 
information about selecting Rational Synergy as your source control plug-in, see Selecting 
the source control plug-in. 
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To close the IBM Rational Synergy Task view while you are using the integration, close the 
view just as you would if you were closing any of Microsoft Visual Studio's views/windows. 

To reactivate the IBM Rational Synergy Task View, in the Microsoft Visual Studio 2010 main 
menu, click View > IBM Rational Synergy, then select IBM Rational Synergy Task 
View. The IBM Rational Synergy Task View is added to the Microsoft Visual Studio IDE. 

Note: The IBM Rational Synergy Task View is automatically removed from the Microsoft 
Visual Studio 2010 IDE once you disable Rational Synergy as your source control plug-in 
selection. 

Activating the IBM Rational Synergy Change Request view 

The Rational Synergy Change Request View is activated automatically and added to the 
Microsoft Visual Studio IDE when you select Rational Synergy as your source control plug-in. 
For more information about selecting Rational Synergy as your source control plug-in, see 
Selecting the source control plug-in. 
 

 
 

To close the IBM Rational Synergy Change Request View while you are using the integration, 
close the view just as you would if you were closing any of Microsoft Visual Studio's 
views/windows. 

To reactivate the IBM Rational Synergy Change Request View, in the Microsoft Visual Studio 
2010 main menu, click View > IBM Rational Synergy, then select IBM Rational 
Synergy Change Request View. The IBM Rational Synergy Change Request View is added 
to the Microsoft Visual Studio IDE. 

IBM Rational Synergy for Microsoft Visual Studio 2010 Interface7.2.1 Page 12 of 53 



 

Note: The IBM Rational Synergy Change Request View is automatically removed from the 
Microsoft Visual Studio 2010 IDE once you disable Rational Synergy as your source control 
plug- in selection. 

Project setup and migration 

Project setup and data migration is the process of starting a project in Microsoft Visual 
Studio 2010 and controlling the same project under Rational Synergy configuration 
management. The following sections describe this process. 

 Project mapping 

 How to migrate 

 Building your application in Visual Studio 

 Migrating to Rational Synergy 

 Migrating from within Microsoft Visual Studio 

Project mapping 

A Visual Studio Solution consists of many projects. These projects may be located anywhere 
in the file system.  Project mapping is the process of defining how a Visual Studio project 
corresponds to a project in Rational Synergy. This integration maps a Visual Studio Solution 
and its projects to Rational Synergy projects according to the following rules. 

1. A Solution is mapped to a project in Rational Synergy with an absolute work area. 
In Rational Synergy, the Solution is the top-level project. 

2. A project that is located inside the Solution directory in the file system may be 
migrated as a project or a directory in Rational Synergy. 

 If a project is migrated as a project, it must have a relative work area and 
is defined as a subproject of the Solution project (top-level project) in 
Rational Synergy. 

 If a project is migrated as a directory, it must have a relative work area 
and is defined as a directory of the Solution project (top-level project) in 
Rational Synergy. 

3. A project that is located outside the Solution directory in the file system may only 
be migrated as a project. These types of projects must have an absolute work 
area and will be defined as a subproject of the Solution project (top-level project) 
in Rational Synergy. 

 

Other recommendations: 

If the option Show Miscellaneous Files in Solution Explorer is enabled in Tools > Options > 
Environment > Documents, the files that are placed in the Miscellaneous Files folder are 
not be migrated to Rational Synergy when the Solution or Project is migrated. Also, cannot 
migrate the Miscellaneous Files folder and all its files to Rational Synergy separately. To 
learn more about the Miscellaneous Files folder, see the Microsoft Help. 

If the files that are contained in the Miscellaneous Files folder are important and you would 
like to control the files under Rational Synergy, you may do one of the following: 
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 Create a Solution folder and place the files in the Solution folder. Files contained in a 
Solution folder are migrated to Rational Synergy when the Solution is migrated. 

 Create a Project folder and place the files in the Project folder. Files contained in a 
Project folder are migrated to Rational Synergy when the Solution or Project is 
migrated. 

Note: You may also migrate files in a Solution or Project folder by performing the Add 
Uncontrolled Files operation. For more information about the Add Uncontrolled Files 
operation, see Adding new files and folders to databases. 

How to migrate 
For your Solutions/Projects to work effectively in a team environment, it is important that 
they are structured properly. When you structure your Solutions and Projects, make sure 
that your Solutions and Projects have a relative work area. You can accomplish this in two 
ways. 

 When creating your Solutions and Projects, ensure that all of the Projects contained 
in your Solutions have a relative work area instead of an absolute work area 

 Modify your Solution files so that the Project paths are relative rather than absolute. 

Building your application in Visual Studio 
Before you can migrate Solutions and Projects to Rational Synergy, you must first prepare 
and build your Solutions and Projects in Visual Studio.  Ensure that you have done the 
following before you migrate your projects to Rational Synergy. 

1. Prepare the Solutions and Projects that you want to migrate to Rational Synergy 
by creating/opening the Solutions and Projects in Visual Studio. 

2. Ensure that the application builds properly in Visual Studio and that all the 
files/folders that you want to control under Rational Synergy are in your work 
area. 

Your project is now ready for migration. 

Migrating to Rational Synergy 
Caution:  Before you migrate your Solutions/Projects to Rational Synergy, make sure that 
you have installed the Microsoft Visual Studio file types into your Rational Synergy database.  

To read more about how you can install the Microsoft Visual Studio file types into your 
Rational Synergy database, see the Installing Visual Studio file types and ignore rules. 

There are two ways to migrate projects to Rational Synergy, one from Rational Synergy 
directly, and the other from the Microsoft Visual Studio IDE by using the integration. This 
section explains the Migrating from within Microsoft Visual Studio process. 

Also, once you have properly migrated your Solutions and Projects to Rational Synergy, you 
must rebuild and baseline your projects (see Rebuilding and baselining your project). 

Migrating from within Microsoft Visual Studio 

Read this section to understand the process of migrating Solutions and Projects from within 
the Microsoft Visual Studio IDE by using the integration. 
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Before you migrate your Solutions/Projects to Rational Synergy, make sure that all of the 
project path/files are not locked. The integration needs to move and rename the project 
files during the process of migration and if any of the project path/files are locked, the 
integration cannot migrate the Solutions/Projects properly. 

If your Solution contains a project which has the same name as the Solution, make sure 
that your Rational Synergy database is set to support multiple project instances. If you 
decide not to set your Rational Synergy database to support multiple project instances, you 
must do one of the following in order for the project migration to work properly. 

1. Rename the Solution by renaming the following: 

 .sln file 

 The directory containing the .sln file 

2. Rename the Project by renaming the following: 

 project file 

 the directory containing the project file 

Caution: When you rename the directory containing the project file, you must also update 
the Solution file so that it points to the renamed project. 

For the integration to perform the migration, you must have a defined connection to an 
Rational Synergy database to which you want to migrate the project. For information about 
creating a connection, see Connection management. 

Carefully follow the steps below to migrate your Solutions and Projects to Rational Synergy. 

1. Ensure that you have a Rational Synergy connection. 

2. Right click the Solution in the Solution Explorer. 

3. Select the IBM Rational Synergy option, then select Create Project in IBM 
Rational Synergy. Or from the Microsoft Visual Studio 2010 main menu, click 
File > IBM Rational Synergy, then select Create Project in IBM Rational 
Synergy. 
 
Specify whether you want the projects created as a project or as a directory. 
Remember that projects located outside the Solution directory in the file system 
may only be migrated as a project, and projects located inside the Solution 
directory in the file system may be migrated as a project or a directory. 
 
Remember that ASP.Net Web Application projects whose location in the file 
system is inside the directory of another Project or Solution directory may only be 
migrated to Rational Synergy as a directory when using the integration. 
 
By using the Create Project in IBM Rational Synergy dialog box, you can choose 
not to migrate some of the projects in your Solution. 
 
Caution: If you choose not to migrate the Solution, you cannot migrate any of 
the projects that are located inside the Solution directory in the file system. The 
only way to migrate projects located inside the Solution directory is by also 
choosing to migrate the Solution. 

4. Select the appropriate Connection Name, Release, Purpose, Platform, Default 
Task, and write an appropriate Description. 
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5. Click Create to view the progress dialog box. 
 
If the database currently selected for project migration is not set to PRESERVE 
case, the integration warns users before migrating the Solutions/Projects. 

6. When project creation is finished, Microsoft Visual Studio will display a warning 
dialog box stating that the Solution has been modified outside the environment. 
Before you respond to the Conflicting File Modification Detected dialog box, make 
sure that the progress dialog box has disappeared. 

 
7. Click Overwrite. Microsoft Visual Studio prompts you to save the Solutions by 

displaying a dialog box. You must click Yes to save the current state of your 
Solutions and Projects. 

 
 

8. The Solutions and Projects files are now properly decorated in the Solution 
Explorer. 
 
Note: Web projects are not display glyphs even if they are controlled. 
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9. From the Microsoft Visual Studio 2008 main menu, click File > Save All. Your 
Solutions and Projects are now controlled under Rational Synergy. 

Rebuilding and baselining your project 

Your Solutions and Projects are now in Rational Synergy. Perform the following steps to 
baseline the Projects. You must rename the directory containing the Solution in the file 
system to ensure that all of the necessary files have been migrated when the Solution is re-
built after you perform the Open Project operation. 

1. Open the Microsoft Visual Studio IDE. 

2. Open the projects that you just migrated to Rational Synergy by using the 
integration. Click the Open Project button located in the IBM Rational Synergy 
Taskbar or by selecting the Open Project option from the IBM Rational Synergy 
menu: 
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IBM Rational Synergy Taskbar Open Project Option 

 

 
 

3. The Open IBM Rational Synergy Project dialog box opens and displays all of the 
working projects, including prep projects. The Open IBM Rational Synergy Project 
dialog box also displays the available project versions for each project. 

4. Select the appropriate project and version that you want to open. 

5. Click Open. When you open a project: 

 The project and version that you selected will be opened as a Visual 
Studio Solution/Project in the Microsoft Visual Studio 2010 IDE. 

 The Solution and Project files will be displayed in the Solution Explorer 
with appropriate decorators that indicate their current source control 
status. 

6. Rebuild the Solutions and/or Projects that you just opened. 

7. To baseline the Projects, you may be required to use the Rational Synergy Client. 
You must have the build_mgr or ccm_admin role. 
 
If you do not have either role, make sure all the tasks are checked in and that no 
files in your Rational Synergy project are checked out. Now you can ask your 
build manager or administrator to baseline your project. Baseline projects are in 
a non-modifiable state, such as released, integrate, and so on. 
 
For more information about baselining projects, see the Rational Synergy 
information center 
(http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.syner
gy.manage.doc/topics/s_t_bmg_baselining_projs.html). 

Setting up a development project 

Once you have baselined your projects, delete your work area. Your work area is no longer 
valid. You should copy the project and open that project in Microsoft Visual Studio to 
continue with the development process. When you copy the project, you get a new working 
copy of the project. It is important that you have a working copy of the project in order to 
make any changes. 
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To get a working copy of a project, you must copy a project. 

After you have successfully copied the project, open the project from the file system. 

Copying a project 
Before you can continue with the development process, you must first get a new working 
copy of the project. You can do this by using the Copy Project operation provided to you by 
the integration. The following information will explain the process of copying a project. 

 The Copy Project operation requires that the .sln file and all project files be non-
modifiable (integrate state). After executing the Copy Project operation, you may be 
prompted by the integration to check out the .sln file and all project files, always 
select Yes. 

 Before performing the Copy Project operation, make sure that the new work area 
location is empty. 

 When copying projects, ensure that your work area template includes project specific 
information that includes the project version and project instance. 

To copy a project: 

1. Open the Microsoft Visual Studio IDE. 

2. Copy the project that you have controlled under Rational Synergy. 
 
You may do this by clicking Copy Project located on the IBM Rational Synergy 
Taskbar or by selecting Copy Project from the IBM Rational Synergy menu: 
 

 
IBM Rational Synergy Taskbar Copy Project Option 
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3. The Copy IBM Rational Synergy Project dialog box opens. The value in the New 
Version box is the next version recommended by the integration. The Copy IBM 
Rational Synergy Project dialog box displays all of the available projects and 
project versions. 

4. Select the project and project version that you want to copy. Also, make sure 
that the appropriate Connection Name, Current Task, Scope, New Version, 
Release, Purpose, and Work Area for the project that you are copying are set 
properly. If you need further help understanding and setting the available options, 
go to the Rational Synergy information center to read more about copying 
projects. 

5. Click Copy to copy the project. 

 

If you want to copy the subprojects, select the checkbox next to the Also Copy Subprojects 
option. 

Opening a project from the file system 

If you have a working project and you know its location in the file system, you can also 
open the project by using the Microsoft Visual Studio IDE's Open Project/Solution menu. 

1. Open the Microsoft Visual Studio 2010 IDE. 

2. On Visual Studio's main menu, click File > Open, then select Project/Solution. 

3. Locate the Project/Solution that you want to open and then open it. Microsoft 
Visual Studio opens the Project/Solution that you selected. The Project/Solution 
is added to the Solution Explorer. 

4. To connect the Project/Solution to Rational Synergy, select the Solution or 
Project in the Solution Explorer, then select the Connect option from the IBM 
Rational Synergy menu. The integration displays the Select Connection dialog box. 
Use this dialog box to select a connection. 
 
If you connect the Solution, the Solution and all the Projects contained in the 
Solution is connected to Rational Synergy. If you connect only the Project, just 
the Project that you selected is connected to Rational Synergy. 

5. Select the appropriate connection by highlighting it, then clicking Select. 
 
The Project/Solution that you opened is now connected to Rational Synergy. 

6. Once you are connected, from the Microsoft Visual Studio IDE's main menu, click 
File > Save All to save all of the files. 
 
The next time you open this project or solution, the project or solution opens as 
connected. 

Getting familiar with the integration 

This section outlines some of the new options and features that are provided in the 
integration. Read the following sections to understand how to use the integration to its full 
potential. 

 IBM Rational Synergy Taskbar 
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 IBM Rational Synergy Output Console window 

 IBM Rational Synergy views 

 Toolbar operations 

 Pop-up menu operations 

 Symbols 

 Tooltips 

 Settings 

IBM Rational Synergy Taskbar 

The IBM Rational Synergy Taskbar and menu offer a quick way to perform task, project, and 
settings operations. 

 
These operations are further described in the following sections. 

Creating a task 
Use the Create Task menu option or click  to open the Create Task dialog box. Fill in all of 
the available options (Task Synopsis, Resolver, Release, Priority, Platform, Subsystem, 
Estimated Effort, Estimated Date, and Description), then click Create to create a new task. 
The newly created task will become your current task. 

Completing a task 
Use the Complete Task menu option or click  to open the Complete Task dialog box. When 
the Complete Task dialog box opens, the current task is  automatically selected. 

1. Select the task that you want to complete. 

2. Select or fill in the following options (Connection Name, Actual Effort, and 
Description), then click Complete to complete the selected task. 

You must refresh the status of your Solution in to see the updated version control status 
symbols. For more information, see Refreshing the Version Control Status. 
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Showing task properties 
Use the Show Task menu option or click  to open the Task Properties dialog box. You can 
view and/or make any changes to the task properties. When you are done, click OK to save 
the changes to the task properties. 

Selecting a task 

Use the Select Task menu option or click  to open the IBM Rational Synergy Select Task 
dialog box.  

The IBM Rational Synergy Select Task dialog box displays the current task in the color 
purple. Select the task that you want to set as your new current task by highlighting the 
task row, then click Select to set the task that you selected as the current task. 

If the task that you want to set as the current task is not available, click Create Task to 
create a task. The new task is set as the new current task. 

Opening a project 

Use the Open Project menu option or click  to open the Open IBM Rational Synergy 
Project dialog box. 

The Open IBM Rational Synergy Project dialog box shows all of the projects that match the 
Project Scope that you selected. Select the project and project version that you want to 
open, the click Open. The selected project version are added to your workspace. 

Showing the Rational Synergy interface 

Use the Show IBM Rational Synergy menu option or click  to launch Rational Synergy. 
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Task box 
The Task box is available with the IBM Rational Synergy Taskbar. This box is used to 
select/view the task for the current default Rational Synergy connection. 

 

 
 

The Task box always displays the current task for the default connection. If there is no task 
set as current, the box displays NONE. If there is no default Rational Synergy connection or 
the current default connection is not connected, the box displays Not Connected. 

To connect to Rational Synergy using the Task box: 
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1. Ensure that you have a default Rational Synergy connection set (see Connection 
management). 

2. On the Task box, select Connect to IBM Rational Synergy. 
 
The integration attempts to connect to Rational Synergy and the Connecting to 
IBM Rational Synergy progress dialog box opens. 

Result:  A session is started for the default connection. The box is populated with all of the 
assigned tasks for the corresponding session. 

You can also use the Task box to disconnect the default connection from Rational Synergy 
by selecting Disconnect From IBM Rational Synergy. The session corresponding to the 
default connection is disconnected and the Task box displays Not Connected. 

 If there is no default connection set and you try to perform an action related to the 
Task box, you are prompted to select a default connection. 

 If no connections are available and you try to perform an action related to the Task 
box, you are prompted to create a default connection. 

Working offline 

Use the Work Offline menu option or click  to use the integration offline. Once you select 
the Work Offline menu option or icon, the integration automatically switches to Offline Mode. 
The integration does not provide any of its normal capabilities while operating offline, and 
any attempt to connect to a Rational Synergy database is not allowed. 

When the integration is in Offline Mode, the following conditions apply: 

 The integration exits all running Rational Synergy sessions. 

 The integration disables the IBM Rational Synergy Taskbar and Menu with the 
exception of the Work Offline icon and menu option. 

 The integration disables the IBM Rational Synergy Team Menu. 

 The integration disables the IBM Rational Synergy Task and Change Request Views. 

 The integration does not allow users to rename Solutions, Solution files, Projects, 
and Project files within the Visual Studio IDE. 

 The integration does not allow users to move Solutions, Solution files, Projects, and 
Project files around within the Visual Studio IDE. 

 The move and rename operations are prevented while offline in order to prevent 
irreconcilable conflicts with the Rational Synergy database. 

Restrictions 

Although the Save as, Rename, and Move operations are restricted while offline, certain 
restrictions do apply and are listed below: 

 Save as 

o Solutions - When performing a Save as operation on Solutions, a new 
instance of the object is not created and none of the objects are changed. 

o Projects - When performing a Save as operation on Projects, a new instance 
of the object are not created, but if the read-only attribute of the Solution 
(.sln) file is enabled, the integration automatically disables it. 
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o Solution files - When performing a Save as operation on Solution files, the 
integration creates a new instance of the object having the new name in the 
file system, but the original object remains in the Solution Explorer and in the 
file system.  If the read-only attribute of the Solution (.sln) file is enabled, 
the integration automatically disables it. 
 
Caution: If you perform the Save as operation on Solution files while offline 
and the read- only attribute of the Solution (.sln) file is currently disabled, 
the Solution project is not stored as a modified project even-though a new 
object was added in the file system. 

o Project files - When performing a Save as operation on Project files, the 
integration creates a new instance of the object having the new name in the 
file system and replaces the original object in the Solution Explorer. The 
original object remains in the file system. If the read-only attribute of the 
Project (.proj) file is enabled, the integration automatically disables it. 

 Rename 

o Solutions - The integration does not allow renaming of Solutions while offline. 

o Projects - The integration does not allow renaming of Projects while offline. 
However, if you attempt to rename a Project and the read-only attribute of 
the Solution (.sln) file is enabled, the integration automatically disables it. 

o Solution files - The integration does not allow renaming of Solution files while 
offline. However, if you attempt to rename Solution files and the read-only 
attribute of the Solution (.sln) file is enabled, the integration automatically 
disables it. 

o Project files - The integration does not allow renaming of Project files while 
offline. However, if you attempt to rename Project files and the read-only 
attribute of the Project (.proj) file is enabled, the integration automatically 
disables it. 

 Move into, Drag and Drop, and Copy and Paste 

o Solutions - Solutions are restricted from being moved. 

o Projects - Projects are restricted from being moved. 

o Solution files - The integration does not allow you to perform the Move into 
operation on Solution files while offline. However, if you attempt to perform 
the Move into operation on Solution files and the read-only attribute of the 
destination Project (.proj) file is enabled, the integration automatically 
disables it. The integration does allow you to Drag and Drop and Copy and 
Paste Solution files to Projects. 

o Project files - The integration does not allow you to Drag and Drop or Copy 
and Paste Project files to a Solution while offline. However, if you attempt to 
perform these operations and the read-only attribute of the Solution (.sln) 
file is enabled, the integration automatically disables it. The integration does 
allow you to Drag and Drop and Copy and Paste Project files between Projects. 
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Switching back to Online Mode 
If you are finished working offline, notify the integration to reconnect to Rational Synergy. 
To do this, select the Work Offline menu option or click . The integration automatically 
switches back to Online Mode. 

When the integration returns to Online Mode, the following conditions apply: 

 The integration starts all the Rational Synergy connections saved. 

 The integration enables the IBM Rational Synergy Taskbar and Menu. 

 The integration enables the IBM Rational Synergy Team Menu. 

 The integration enables the IBM Rational Synergy Task and Change Request Views. 

 The integration now allows move and rename operations to be performed on 
Solutions, Solution files, Projects, and Project files from within the Visual Studio IDE. 

 The integration notifies the user of any Solutions and Projects that were modified 
while the integration was offline. This is accomplished in the following ways: 

o When returning online, the integration displays a list of Solutions and Projects 
that were modified while working offline by using the IBM Rational Synergy 
Synchronize Projects dialog box. 
 
The IBM Rational Synergy Synchronize Projects dialog box allows you to 
synchronize projects one at a time from the list. Once a project has been 
synced, it is automatically removed from the list. If you choose not to 
synchronize the projects upon returning online, select Cancel. Remember 
that choosing not to sync projects may result in work area conflicts. 
 
Note: Once you choose a project from the list and select Sync, make sure 
you finish synchronizing that project first before selecting another project 
from the list. This means that keeping all the work area changes that you 
want from the IBM Rational Synergy Work Area Conflicts dialog box and then 
exiting. 

o Once you are back online, you can use the IBM Rational Synergy Team Menu 
options. If you attempt to perform a Team operation on a Solution or Project 
on the list that has not been synchronized, the integration warns you that the 
project is out of sync by displaying a dialog box. 
 
The Out of Synced Project Warning dialog box asks if you want like to sync 
the project now. 

o If you choose to sync the project now, the Team operation you are trying to 
perform will not continue for the selected Solution or Project. Instead the IBM 
Rational Synergy Work Area Conflicts dialog box opens. After you have 
finished synchronizing the project, you must re-select the Team operation to 
continue. 

o If you choose to sync the project later, the Team operation you are trying to 
perform continues as normal. 
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IBM Rational Synergy Output Console window 

The integration uses Microsoft Visual Studio 2010 IDE output window to show results of 
various source control operations. Use this view to check for any error or warning messages 
when performing version control operations. 

IBM Rational Synergy views 

IBM Rational Synergy for Microsoft Visual Studio Interface provides the following views: 

 IBM Rational Synergy Task View 

 IBM Rational Synergy Change Request View 

If you rename or delete a saved task or change request query by using Rational Synergy 
and that query is currently being displayed in the view, you can update the information 
being shown on the IBM Rational Synergy views: 

1. Perform the Refresh operation on the view. 

2. Re-expand the connection element that contained that saved task or change 
request query. 

If you rename a saved task or change request query by using Rational Synergy and that 
query is currently being displayed in the view, after you perform the above steps, you must 
add the renamed query to the view again by performing the Add Saved Query operation. 

For more information about the Add Saved Query operation, see: 

 Add Saved Task query 

 Add Saved Change Request query 

IBM Rational Synergy Task view 

The integration provides a view designed to work with Rational Synergy tasks. When you 
open the IBM Rational Synergy Task View without creating any connections, the view is 
empty. 

The IBM Rational Synergy Task view displays an element for each connection defined in the 
integration: 

 Each connection element is decorated with the connection name. 

 The default connection is represented by a green connection icon. 

 All other connections are represented by a blue connection icon. 

 If there is no default connection defined, all connection elements are represented by 
a blue connection icon. 

Each connection element can be expanded to display the task queries saved for that 
connection: 

 Each task query is decorated with the query name. 

 All task queries are represented by a task query icon. 

 Initially, the integration displays three standard saved task queries for each 
connection: "My Assigned Tasks", "Tasks I Completed This Week", and "Tasks I 
Completed Last Week". 
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Each task query displayed in the view can be expanded to display all the tasks that match 
the given query: 

 Each task is decorated with the task number and the task synopsis. 

 All tasks are represented by a task icon. 

Each task displayed in the view can be expanded to show all the objects associated to that 
task: 

 Each object is decorated with the file or folder name and its version. 

 All objects are represented by either a file or folder icon. If the object is a file, it is 
represented by a file icon, and if the object is a folder, it is represented by a folder 
icon. 

 The objects' icons reflect their status. Objects that are currently in working (checked 
out) state is represented by a file or folder icon that is checked and objects that are 
currently in static (checked in) state are represented by a file or folder icon that is 
unchecked. 

You can drag and drop objects between assigned tasks: 

 The integration does not allow you to drag and drop objects between completed 
tasks. 

 The integration does not allow you to drag and drop objects between different 
connections. 

Note: The drag and drop feature in the IBM Rational Synergy Task View is only available for 
objects. 
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The following toolbar operations are available from the IBM Rational Synergy Task View. 

 Refresh View 

 Add Saved Task Query 

IBM Rational Synergy Change Request view 

The integration provides a view designed to work with IBM Rational Synergy change 
requests. If you open the IBM Rational Synergy Change Request View without creating any 
connections, the view is empty. 

The IBM Rational Synergy Change Request View displays an element for each connection 
defined in the integration. 

 Each connection element is decorated with the connection name. 

 The default connection is represented by a green connection icon. 

 All other connections are represented by a blue connection icon. 

 If there is no default connection defined, all connection elements are represented by 
a blue connection icon. 
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Each connection element can be expanded to display the change request queries saved for 
that connection. 

 Each change request query is decorated with the query name. 

 All change request queries are represented by a change request query icon. 

 Initially, the integration displays one standard change request query for each 
connection: "My Assigned Change Requests". 

 If the IBM Rational Synergy to IBM Rational Change integration is not enabled for a 
connection, the integration displays a message stating: "Change Requests are not 
enabled on this connection" for that connection. This is the only element displayed 
below that connection node and the pop-up menu operations are disabled for the 
connection. 

Each change request query displayed in the view can be expanded to display all the change 
requests that match the given query. 

 Each change request is decorated with the change request number and the change 
request synopsis. 

 All change requests are represented by a change request icon. 

Each change request displayed in the view can be expanded to display all the tasks 
associated with that change request. 

 Each task is decorated with the task number and the task synopsis. 

 All tasks are represented by a task icon. 

Each task displayed in the view can be expanded to show all the objects associated to that 
task. 

 Each object is decorated with the file/folder name and its version. 

 All objects are represented by either a file or folder icon. If the object is a file, it is 
represented by a file icon, and if the object is a folder, it is represented by a folder 
icon. 

 The icons of the objects reflect their status. Objects that are currently in working 
(checked out) state are represented by a file/folder icon that is checked and objects 
that are currently in static (checked in) state is represented by a file/folder icon that 
is unchecked. 

You can drag and drop tasks between assigned change requests. 

 The integration does not allow you to drag and drop tasks between change requests 
that are not assigned. 

 The integration does not allow you to drag and drop tasks between different 
connections. 

You can drag and drop objects between assigned tasks. 

 The integration does not allow you to drag and drop objects between completed 
tasks. 

 The integration does not allow you to drag and drop objects between different 
connections. 

Note: The drag and drop feature in the IBM Rational Synergy Change Request View is only 
available for tasks and objects. 
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Toolbar operations 

The IBM Rational Synergy Views offer a quick way to refresh and add queries to the view 
through the use of the following toolbar operations: 
 

 
 

 Refresh View 

 Add Saved Task Query (only available in the IBM Rational Synergy Task View) 

 Add Saved Change Request Query (only available in the IBM Rational Synergy 
Change Request View) 

Refresh view 

Click the  Refresh icon from the IBM Rational Synergy View's toolbar (task or change 

request) to update the contents of the view. When you click , the contents of the view 
are updated. 
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Add Saved Task query 
You may display additional saved task queries to the IBM Rational Synergy Task View.  

To add a task query to the IBM Rational Synergy Task View: 

1. Click the  Add Saved Query icon from the IBM Rational Synergy Task View's 
toolbar. 

2. The Select Query dialog box opens. 

 The Select Query dialog box initially displays the saved task queries for 
the default connection. 

 The task queries that you created is displayed in bold font. Other task 
queries will be displayed in regular font. 

 If there is no default connection set, the Select Query dialog box displays 
NONE in the Connection Name box. 

3. Select the Connection Name and task query that you want to add to the view. 

4. Click OK to add the selected task query to the IBM Rational Synergy Task View. 

Add Saved Change Request query 
You may display additional saved change request queries to the IBM Rational Synergy 
Change Request View. 

To add a change request query to the IBM Rational Synergy Change Request View: 

1. Click the  Add Saved Query icon from the IBM Rational Synergy Change 
Request View's toolbar. 

2. The Select Query dialog box opens. 

 The Select Query dialog box initially displays the saved change request 
queries for the default connection. 

 The change request queries that you created are displayed in bold font. Other 
change request queries are displayed in regular font. 

 If there is no default connection set, the Select Query dialog box displays 
NONE in the Connection Name box. 

 If the connection selected does not have the Rational Synergy to Rational 
Change integration enabled, the Select Query dialog box displays NONE in 
the change request query list box. 

3. Select the Connection Name and change request query that you want to add to 
the view. 

4. Click OK to add the selected change request query to the IBM Rational Synergy 
Change Request View. 

Pop-up menu operations 

With the exception of connection elements, the IBM Rational Synergy Views provide the 
following menu operations: 

 Cutting a query 

 Refreshing a query 
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 Viewing change request properties 

 Viewing task properties 

 Completing a task 

 Viewing object properties 

Cutting a query 
To cut a query from the view: 

1. On the IBM Rational Synergy View, select the query (task or change request) that 
you want to remove from the view. 

2. Right-click the selected query and select Cut from the menu options. The query 
selected is removed from the IBM Rational Synergy View. 

Note: When you perform the Cut operation on a query (task or change request), the query 
is not deleted. It is only removed from the IBM Rational Synergy View. 

Refreshing a query 
To refresh the contents of a query: 

1. On the IBM Rational Synergy View, select the query (task or change request) that 
you want to refresh. 

2. Right-click the selected query and select Refresh from the menu. The contents 
of the query is updated. 

Viewing change request properties 
To view the properties of a change request: 

1. On the IBM Rational Synergy View, select the change request that you want to 
view. 

2. Right-click the selected change request and select Properties from the menu. 
The Rational Change show form for the selected change request opens. 

To view the properties for a change request that is associated to a task: 

1. On the IBM Rational Synergy View, select the task whose change request 
properties you want to view. 

2. Right-click the selected task and select Change Request Properties from the 
menu options. The Rational Change show form for the change request that is 
associated to the selected task opens. 

Viewing task properties 
To view the properties of a task: 

1. On the IBM Rational Synergy View, select the task that you want to view. 

2. Right-click the selected task and select Properties from the menu. The Task 
Properties dialog box for the selected task opens. 

Completing a task 
To complete a task from the IBM Rational Synergy View or views: 

1. On the IBM Rational Synergy View, select the task that you want to complete. 
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2. Right-click the selected task and select Complete from the menu. The Complete 
Task dialog box opens. 

 The task that you selected is shown in the Complete Task dialog box. 

 If the task that you selected is already completed, the default task is selected 
in the Complete Task dialog box. 

 If no default task is set, the first task listed in the Assigned Tasks box is 
selected. Otherwise, no task is selected. 

Viewing object properties 
To view the properties of an object: 

1. On the IBM Rational Synergy View, select the object that you want to view. 

2. Right-click the selected object and select Properties from the menu. The IBM 
Rational Synergy Properties dialog box for the selected object opens. 

Symbols 
When Solutions and Projects in Microsoft Visual Studio are connected to Rational Synergy, 
the Solution and Project files are decorated to give a visual indication that the project is 
under Rational Synergy. The following information describes what each symbol indicates. 

 Checked Out - The object is currently checked out and modifiable. 

 
 Checked Out by Another User - The Solutions and Projects controlling the object are 

checked out using a Shared Purpose and the object is currently checked out by 
another user. 

 
 Checked In - The object is currently checked in and not modifiable.  

 

Tooltips 
The integration displays additional information about a project/file/folder through the use of 
tooltips.  

To open the tooltips, in the Microsoft Visual Studio Solution Explorer, place the mouse tip 
over the project/file/folder icon. 

You should see source control information about the project/file/folder, such as its name, 
version, owner, status, and release. 

For example: name-version:owner:status:release 

Note: Although folders and directories support version control operations, symbols and 
tooltips are not visible for folders or directories. 

Settings 
You can manage the Rational Synergy integration settings by using the Settings menu 

option or by clicking . This feature specifies how the integration functions and connects 
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to Rational Synergy. Read the following information to understand more about how to 
manage the Rational Synergy integration settings. 

1. Use the Settings menu option or click  to open the IBM Rational Synergy 
Settings dialog box. 
 
The IBM Rational Synergy Settings dialog box contains the following settings: 
 
Connection management 
General settings 

2. View or modify the options in the IBM Rational Synergy Settings dialog box. 

3. When you are finished, click OK to save the changes that you have made and 
exit the IBM Rational Synergy Settings dialog box. 

Connection management 

This feature specifies how the integration connects to Rational Synergy. The following 
Connection Management operations are available in the IBM Rational Synergy Settings 
dialog box through a menu option called Connection Management. 

 
 

Connection Management menu 
Connection Management offers the following capabilities: 

 Add Connection - This operation opens a New IBM Rational Synergy Connection 
dialog box. If the connection being added is the first connection or if there is 
currently no default connection set, the connection is set as the default connection. 
Otherwise, it is set as a regular connection. 
 
Fill in the connection information (Connection Name, User Name, Password, 
Database Path, Engine Host, Client Home, and Client Database). Ensure that all the 
fields are filled in, then click Connect to save the connection and start a Rational 
Synergy session. 

 Start Session - You can explicitly start a Rational Synergy session for a certain 
connection by selecting the connection in the IBM Rational Synergy Settings dialog 
box and clicking Start. If you perform a source control or task operation and a 
session is not already started, the integration automatically starts the default 
connection. 
 
Clicking Start twice does not start another session. If a session is explicitly (by 
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clicking Start) or implicitly (performing a team operation) started from the 
integration, it reuses a session this is already started by the integration. 

 Delete Connection - This operation deletes the selected connection. If the selected 
connection has a session running, the session is terminated before deleting the 
connection. To delete a connection that is being used by a Solution in Visual Studio, 
you must disconnect the Solution first. 

 Stop Session - This operation stops the Rational Synergy session for the selected 
connection. 

 Make Default - The connection that you select becomes the default connection. The 
default connection is the connection that is automatically used in all Task dialog 
boxes and project wizards. 

 Clear Default - This operation clears the default connection. This means that no 
default connection is set. If there is no default connection, NONE displays in the 
Connection Name field wherever applicable. The Show Task and Show IBM Rational 
Synergy taskbar and menu options and the Task box option are not available when 
no default connection is set. 

 Properties - You can view the connection properties by double-clicking a connection 
or selecting the Properties option from the Connection Management menu. When the 
connection is currently in Connected status, you may not modify the connection 
properties. You may only modify the connection properties when the connection is in 
Disconnected status. 

General settings 

This feature of the integration specifies how the integration will function with Rational 
Synergy. You may configure your IBM Rational Synergy integration settings by setting the 
following options according to your preference. 

The following information describes the functionalities of each General Settings option. Set 
the following preferences by checking the check box next to the option. 

 Check Out file(s) automatically when edited. 
 
When the Check Out file(s) automatically when edited option is selected, the 
following occurs: 

o The integration automatically checks out files when you modify them. 

o The integration updates the symbols to represent the updated source control 
status of the files. 

When the Check Out file(s) automatically when edited option is cleared, the 
following occurs: 
 
When you try to modify any file, the integration displays the following dialog box. 
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You must click Yes to check out the file. If you select No, you can continue to 
modify the file. However, when you try to save the file at a later time, the integration 
prompts you again to check out the file in order to keep your changes. 
 
Once the file is properly checked out, the integration updates the symbol to 
represent the updated source control status of the file. 

 Prompt to add new project files to IBM Rational Synergy - This option is used when 
new files are added to the connected Project/Solution. 
 
When the Prompt to add new project files to IBM Rational Synergy option is selected, 
the following will occur: 

o When you add new project files to a Project/Solution, the integration prompts 
you to add the files to Rational Synergy by displaying the IBM Rational 
Synergy Add Files dialog box 

o Click Add to add the files to Rational Synergy. You should see the Add 
Uncontrolled Files progress dialog box opens. 

o The files are controlled under Rational Synergy. 

When the Prompt to add new project files to IBM Rational Synergy option is cleared, 
the following occurs: 

o When you add new project files to a Project/Solution, those files will not be 
controlled in Rational Synergy. You must add the uncontrolled files to Rational 
Synergy to perform source control operations on them. 

o For more information about adding uncontrolled files and folders to IBM 
Rational Synergy, see Adding new files and folders to databases. 

 Notify for parallel versions on check out. 

 Notify for parallel versions on check in. 

 Prompt for the DB case mode information - This option is selected by default. 
 
When the Prompt for the DB case mode information option is selected, the following 
occurs: 

o When you perform any of the operations listed below, the integration prompts 
you to select the proper database case mode that was used when the 
Solutions or Projects were migrated to Rational Synergy. The integration 
displays the Select Database Mode dialog box, so that you can select the 
proper database case mode to use. 

Use the Connect option from the IBM Rational Synergy team menu to connect to 
solutions and projects to Rational Synergy. 

Use the Open Project option from the IBM Rational Synergy taskbar to open projects 
or solutions. 

Use the Copy Project option from the IBM Rational Synergy taskbar to copying 
Solutions/Projects. 

When the Prompt for the DB case mode information option is cleared, the following 
occurs: 
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o The integration does not display the Select Database Mode dialog box when 
you perform any of the same three operations listed above: Connect, Open 
Project, and Copy Project. By default, the integration uses the database case 
mode PRESERVE to perform all operations, including the Connect, Open 
Project, and Copy Project operations. 

o If you set all of your database(s) to PRESERVE case after installing the 
integration and you never set it back to LOWER or UPPER case, you must 
turn off the Prompt for the DB case mode information option. 

Rational Synergy 'smart-card' login feature 

The Rational Synergy "smart-card" login feature that is included in Rational Synergy is also 
available in Rational Synergy for Microsoft Visual Studio Interface. The "smart-card" feature 
allows users of the integration to create a connection without the need to enter a username 
and password. 

For more information about enabling and disabling the Rational Synergy "smart-card" login 
feature, see the “Non-web-mode trusted users configuration” topic in the Rational Synergy 
information center 
(http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/index.jsp?topic=%2Fcom.ibm.rational.
synergy.admin.doc%2Ftopics%2Fs_c_ag_n_webmode_trustusrs_cnfig.html). 

If the Rational Synergy "smart-card" feature in Rational Synergy is enabled and you try to 
create a new Rational Synergy Connection, the User Name and Password text field are 
disabled in the New IBM Rational Synergy Connection dialog box. The User Name text field 
is automatically filled in with the user's operating system username. You still need to fill in 
the remaining information: Connection Name , Database Path, Engine Host, Client Home, 
and Client Database. 

If the “smart-card" feature in Rational Synergy is disabled and you try to create a new 
Synergy Connection, the User Name, Password, and all of the remaining Connection 
information text fields  are enabled in the New IBM Rational Synergy Connection dialog box. 
You must fill in all of the text fields to create a new Connection and start a Rational Synergy 
session. 

Daily development 

Daily development refers to the activities performed by the team members during everyday 
development. Once a development or a build management project is set up, daily 
development primarily involves the activities of modifying files. Rational Synergy is a task-
based configuration management. To keep track of daily development activities effectively, 
associate them with a Rational Synergy task. This section also describes many other 
operations that can be performed by using the integration. 

Most of these operations are available from the IBM Rational Synergy team menu. 
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The IBM Rational Synergy team menu can be started by using Microsoft Visual Studio's main 
menu. Click File, then select IBM Rational Synergy. You can also start the IBM Rational 
Synergy team menu by right clicking a Solution, Project, folder, or file in Visual Studio's 
Solution Explorer. 

Using task-based CM 
Whenever you check out a file, the check-out operation is tracked with your current task. 
Select a current task before you check out or modify any file. When you are done, check in 
your current task instead of checking in the individual files. To complete a task or to create 
a task, use the IBM Rational Synergy taskbar and/or menu. 

You can set a current task for each Rational Synergy Connection. To do this, you can use 
the IBM Rational Synergy taskbar or menu by choosing the Selecting tasks option. 

Use the Task box from the IBM Rational Synergy taskbar to find out what current task is set 
for the default connection. Or you can use the Select Task option from the IBM Rational 
Synergy taskbar or menu to view the current task for each connection. Choose the 
Connection Name and its corresponding current task is displayed in the Current Task box. If 
there is no current task set for the connection, you see NONE in the Current Task box. 

At times, this integration prompts you to select a current task if you perform an operation 
that requires a task. 
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You can either select an existing task as your current task or create a task. 

Connecting a solution or project 

To connect a Solution/Project to Rational Synergy, perform the following steps. After 
performing this operation, the Solution/Project opened in Microsoft Visual Studio is 
connected to Rational Synergy. 

1. Open the Solution/Project by clicking Microsoft Visual Studio's File > Open > 
Project/Solution. 

2. Select the Solution/Project that you want to connect. 

3. On the IBM Rational Synergy team menu, select the Connect option. The Select 
Connection dialog box opens. You must select the connection that you want to 
use to connect the Solution/Project. 

4. Select a connection from the list and click Select to connect the Solution/Project. 

The selected Solution/Project will now be connected to Rational Synergy.  The integration 
will add the appropriate symbols to the Solution/Project and its files and directories. If at a 
later time, you decide to disconnect the Solution/Project, execute the Disconnect operation. 
See Disconnecting a solution or project. 

Migrating projects 

When you create a new project in Microsoft Visual Studio and you add that project to a 
Solution that is already controlled under Rational Synergy, you must migrate your newly 
created project to Rational Synergy to perform source control operations on the project and 
its files. 

To migrate a project to Rational Synergy: 

1. On the Solution Explorer, select your newly added/created project. 

2. On the IBM Rational Synergy team menu, select Create Project in IBM 
Rational Synergy. 
 
The Create Project in IBM Rational Synergy dialog box opens. The Create Project 
in IBM Rational Synergy dialog box does not allow you to create the Solution in 
Rational Synergy. You must migrate the Solution to Rational Synergy again 
because the Solution is already controlled as a project in Rational Synergy. 
 
There are important cases that you need to be aware of when migrating projects 
to Rational Synergy. 
 
When migrating a project that is located inside the Solution directory in the file 
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system, the project must be migrated to the same Rational Synergy database as 
the Solution. This means that you cannot change the Connection Name when 
creating the project in Rational Synergy. 
 
When migrating a project that is located outside the Solution directory in the file 
system, you can migrate the project to any Rational Synergy database. You can 
change the Connection Name selected in order for the project to be migrated to 
the correct Rational Synergy database. 

3. Click Create to migrate the project to Rational Synergy. 
 
The Create Projects progress dialog Box opens. Once the project is migrated to 
Rational Synergy, Microsoft Visual Studio displays a File Modification Detected 
dialog box. 

 

 
 

4. Click Reload on the File Modification Detected dialog box to see the project and 
its files properly decorated with symbols in the Solution Explorer. 

5. Click File > Save All in the Microsoft Visual Studio 2010 main menu. 

6. When you exit the Microsoft Visual Studio 2010 IDE, Visual Studio prompts you 
to save the Solution by displaying a dialog box. Click Yes to save the current 
state of your Solutions and projects. Your project is now controlled under 
Rational Synergy. 

Adding new files and folders to databases 

If you add new files or folders to your workspace, add them to Rational Synergy as soon as 
possible. 

If the IBM Rational Synergy Settings option, Prompt to add new project files to IBM Rational 
Synergy is selected, the integration automatically prompts you to add new files to Rational 
Synergy. The Prompt to add new project files to IBM Rational Synergy option only applies to 
uncontrolled files. To add uncontrolled folders to Rational Synergy, you must use the Add 
Uncontrolled Files IBM Rational Synergy team menu option. 

If you want to add files/folders to your Solutions/Projects, you should also add them to 
Rational Synergy as soon as possible. You must have a current task set in order to perform 
the Add Uncontrolled Files operation. 

The integration finds the ignored files/folders and those files/folders are not added to 
Rational Synergy. 

The Add Uncontrolled Files operation leaves the added files in the checked-out state.  

IBM Rational Synergy for Microsoft Visual Studio 2010 Interface7.2.1 Page 41 of 53 



To add uncontrolled files/folders to Rational Synergy: 

1. Select the uncontrolled files/folders that you want to add to Rational Synergy. 

2. On the IBM Rational Synergy team menu, click Add Uncontrolled Files. 
 
The IBM Rational Synergy Add Files dialog box opens. 

3. Click Add to add the selected files/folders to Rational Synergy. 
 
A progress dialog box that depicts the status of the Add Uncontrolled Files 
operation opens. The files or folders that you selected are now controlled by 
Rational Synergy. 

Removing files from databases 
If you no longer want to control certain files in Rational Synergy, you may remove them. 

The Remove From IBM Rational Synergy operation removes the files from your 
Solutions/Projects and from Rational Synergy. To keep these files on your local drive, save a 
copy before performing this operation. 

Microsoft Visual Studio offers two additional operations called Exclude From Project and 
Delete. Exclude From Project removes the Solution and Project files from your 
Solutions/Projects. Delete removes the Solution and Project files from your 
Solutions/Projects and from the file system. 

When you perform the Exclude From Project or Delete operations on Solution and Project 
files that are controlled by Rational Synergy, the integration displays the Delete files prompt 
dialog box. If you respond Yes to the dialog box, the Solution and Project files are removed 
from your Solutions/Projects and from Rational Synergy. If you respond No to the dialog 
box, the Solution and Project files are only removed from your Solutions/Projects and not 
from Rational Synergy. 

 

 
 

When you perform the Exclude From Project or Delete operations on Solution and Project 
folders/directories that are controlled by Rational Synergy, the integration displays the 
Delete files prompt dialog box twice. You must then respond twice to the dialog box. This 
limitation is one of the known issues of IBM Rational Synergy for Microsoft Visual Studio 
Interface. 

To remove controlled files from Rational Synergy: 

1. Select the files that you want to remove from Rational Synergy. 

2. On the IBM Rational Synergy team menu, click Remove From IBM Rational 
Synergy. 
 
The IBM Rational Synergy Remove Files dialog box opens. 
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3. Click Remove to remove the selected files from Rational Synergy. 
 
A progress dialog box that displays the status of the Remove From IBM Rational 
Synergy operation opens. The files that you selected are now removed from 
Rational Synergy. 

Synchronizing a work area 

Occasionally, your work area may not be in sync with Rational Synergy. This might happen 
if you modify files outside of Microsoft Visual Studio without performing a check-out 
operation. 

To synchronize your work area: 

1. Select the Solution or Project that you need to sync. 

2. On the IBM Rational Synergy team menu, click Sync. 
 
If there are work area conflicts, the IBM Rational Synergy Work Area Conflicts 
dialog box opens. 
 
A list of work area conflicts display in the dialog box. 
 
Keep the work area changes that you want by selecting the files and clicking the 
Keep Work Area Changes icon at the top of the dialog box or by right clicking on 
the files and selecting the Keep Work Area Changes option. 
 
Discard the work area changes that you do not want by following the same 
procedure but choose the Discard Work Area Changes icon or Discard Work Area 
Changes option instead. 

By performing the above operation, the working files/folders may automatically be checked 
out. For the objects to reflect their updated version control status symbols, you must 
refresh the status of the objects by performing the Refresh Status operation available from 
the IBM Rational Synergy team menu. For more information, see Refreshing the version 
control status. 

If you need further help understanding the Sync operation or the IBM Rational Synergy 
Work Area Conflicts dialog box, see the Rational Synergy information center 
(http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.prodov
erview.doc/topics/s_c_int_synchronize_operation.html). 

Checking out files 
You must check out files before you can start modifying them. 

The Check Out and Check Out Recursive operations are only valid for controlled 
Solutions/Projects/files/folders. 

Only the selected files are checked out. To check out all of a Solution/Project/folder's 
contents at the same time, use the Check Out Recursive operation. 

If you perform the Check Out operation on a file that is located inside a folder, the file and 
its folder are automatically checked out. 

This operation requires a task. If you choose not to specify a current task, the integration 
prompts you to select a task. 
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The following behavior is preference based and can be set by choosing the Settings option 
in the IBM Rational Synergy taskbar or menu. If after executing the Check Out or Check Out 
Recursive operation, the selected files results in parallel versions, you receive a warning. 
For more information, see General settings. 

To check out files: 

1. On the Solution Explorer, select the files that you want to check out. 
 
To perform the Check Out Recursive operation, select only the top most level 
Solution/Project/file/folder. 

2. On the IBM Rational Synergy team menu, click Check Out or Check Out 
Recursive to check out the selected Solution/Project/folder contents. 
 
If you selected the Check Out Recursive option, the IBM Rational Synergy 
CheckOut Operation dialog box opens. 

3. Select/Change your current task and write an appropriate check out comment, 
then click CheckOut to check out the files. 
 
The symbol representing Checked Out is displayed next to the file names. 

Undoing a check out 
When you undo a file check out, the current version of the file or folder is replaced with the 
previous version. If the file or folder has only one version, you are notified. 

If you perform the Undo Checkout operation on a file that is located inside a folder, the 
integration automatically undoes the check out of the file and its folder. 

The integration does not allow the Undo Checkout operation to be performed on files and 
directories that have been checked out as a result of a Rename operation.  

Perform the Undo Checkout operation on these types of files by using one of the following 
methods: 

 Rename the files and/or directories back to their previous names by using Microsoft 
Visual Studio IDE's Rename option. 

 Save and then close the Solution containing the files and/or directories, perform the 
Undo Checkout operation on the Project file and the files and/or directories by using 
the Rational Synergy Delete option, then re-open the solution in the Microsoft Visual 
Studio IDE. 

To undo the check out of files: 

1. On the Solution Explorer, select the files that you do not want checked out.  
 
If you want to perform the Undo Checkout Recursive operation, select only the 
top most level Solution/Project/file/folder. 

2. On the IBM Rational Synergy team menu, click Undo Checkout or Undo 
Checkout Recursive to undo check out of the selected Solution/Project/folder 
contents. 
 
If you selected the Undo Checkout Recursive option, the IBM Rational Synergy 
Undo CheckOut Operation dialog box opens. 
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3. Click Undo to undo check out of the files. 
 
The symbol representing the current source control status of the files is displayed 
next to the file names. 

Checking in files 
The following behavior is preference based and can be set by choosing the Settings option 
in the IBM Rational Synergy taskbar or menu. When performing the Check In operation on 
files that have parallel versions, you receive a notification. See General settings. 

You must complete your task rather than checking in individual files. The Check In and 
Check In Recursive operations should only be used when it is absolutely necessary to check 
in files/folders before the task is complete. 

To check in files: 

1. On the Solution Explorer, select the files that you want to check in. 
 
If you want to perform the Check In Recursive operation, select only the top 
most level Solution/Project/file/folder. 

2. On the IBM Rational Synergy team menu, click Check In or Check In 
Recursive to check in the selected Solution/Project/folder contents. 
 
If you selected the Check In Recursive option, the IBM Rational Synergy CheckIn 
Operation dialog box opens. 

3. Click CheckIn to check in the files. 
 
The symbol representing Checked In is displayed next to the file names. 

Comparing a file or folder with its predecessor 

The Compare with Predecessor operation is only available for files and folders. 

If a file or folder has more than one predecessor, the IBM Rational Synergy Compare dialog 
box opens for each predecessor. 

If you need further help understanding the Compare with Predecessor operation, the IBM 
Rational Synergy Compare dialog box, or the IBM Rational Synergy Directory Compare 
dialog box, see the Rational Synergy information center. 

To compare a version of a file or folder with its predecessor: 

1. On the Solution Explorer, select the files/folders on which you want to perform 
the Compare with Predecessor operation. 

2. On the IBM Rational Synergy team menu, click Compare with Predecessor. 

Viewing the history of objects 
To view the history of objects: 

1. On the Solution Explorer, select the object of which you want to view the history. 

2. On the IBM Rational Synergy team menu, click History. 
 
The IBM Rational Synergy History dialog box opens for the selected object. 
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Viewing or modifying properties of objects 
(File-Folder Properties.html) 

To view or modify the properties of an object: 

1. On the Solution Explorer, select the object on which you want to view the 
properties. 

2. On the IBM Rational Synergy team menu, click Properties. 
 
The IBM Rational Synergy Properties dialog box opens. 

3. View and/or modify the available properties. 
 
For more information about the IBM Rational Synergy Properties dialog box, see 
the Rational Synergy information center 
(http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.syner
gy.manage.doc/topics/sg_t_h_view_props.html). 

If you modify the Version, it is important that you refresh the status of the object (Solution, 
Project, folder, or file) to see the updated version control status symbols. For more 
information, see Refreshing the version control status. 

Using a version of a file or folder 

There are times when you might want to change the version being used for a file or folder. 

To use a different version of a file or folder: 

1. Select the file or folder on which you want to perform the Use Version operation. 
 
You may only select one file/folder at a time. 

2. On the IBM Rational Synergy team menu, select Use Version.  
 
The Use Version dialog box opens for the selected file or folder. The version that 
is currently being used by the file/folder will have a checkbox that is selected. 

3. Select the version that you want to use. 
 
Click Recommend to see the recommended/latest version of the file/folder. 
When you click Recommend, the recommended version is highlighted. 

4. Click Use to change the version of the file/folder to the one that you selected. 
 
The integration will then update the corresponding symbols to reflect the file or 
folder's new source control status. 

You can also use the IBM Rational Synergy team menu's History option to change the 
version being used for a file or folder. 

Updating members 

To get the latest version of project files: 

1. Select the objects on which you want to perform the Update Members operation. 

2. On the IBM Rational Synergy team menu, select Update Members. 
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The Update Members Progress dialog box opens and the selected objects are 
updated. The result of the Update Members operation is displayed in the IBM 
Rational Synergy Output Console Window. 

If you perform the Update Members operation on a project, the project are updated. You 
can select multiple projects for this operation. For more information about the Update 
Members operation, see the Rational Synergy information center 
(http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.rational.synergy.manag
e.doc/topics/sc_r_h_update_command.html). 

Refreshing the version control status 

If a source control operation is performed on the project files outside of the Microsoft Visual 
Studio 2010 IDE, the integration does not display the correct symbol in the Solution 
Explorer (see Symbols and Tooltips). 

For the integration to display the proper symbol representing the most up-to-date status of 
the project files, you can use the Refresh Status operation. 

To refresh the version control status of objects: 

1. Select the objects (Solutions/Projects, directories, or files) on which you want to 
refresh the source control status. 

2. On the IBM Rational Synergy team menu, select Refresh Status. 
 
The selected objects display in the current source control status. 

Disconnecting a solution or project 

If you want your Solutions and/or Projects to behave as if there was no source control 
installed, you may disconnect your Solutions and/or Projects. After performing the 
Disconnect operation, the Solution/Project opened in Microsoft Visual Studio is disconnected 
from Rational Synergy. 

To disconnect a solution or project from Rational Synergy: 

1. Select the Solution/Project that you want to disconnect. 

2. On the IBM Rational Synergy team menu, select Disconnect. 
 
The selected Solution/Project is disconnected from Rational Synergy. The integration 
removes the corresponding symbols for the Solution/Project and its files and 
directories. 

Note: You can connect the solution or project again by executing the Connect operation. 
See Connecting a solution or project. 

Debugging support 

The integration provides support for debugging. Debug support tracks your activities while 
using the integration. You may use the information provided by the Debug support to view 
or correct any errors or warnings that may occur while using the integration. 

A registry entry called the DebugLevel is created once Rational Synergy for Microsoft Visual 
Studio Interface is installed. You may view or change the value of the DebugLevel according 
to your preference by using the Registry Editor. 

The registry key DebugLevel is located here: 
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My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Telelogic\CM 
SYNERGY\Integrations\ccmdc 

Changing the Debug Level value 

To change the value of the debug level: 

1. Open the Registry Editor dialog box. 

2. Change to the following location: 
My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Telelogic\CM 
SYNERGY\Integrations\ccmdc 

3. Modify the registry key DebugLevel to your desired value (0, 1, or 2). 
 
Use the following to help you determine which DebugLevel you would like to use. 
 
0 - No debugging support. The log file remains empty. You may choose this 
DebugLevel to make the integration work faster. 
 
1 - The log file records all the errors, warnings, and exceptions. The DebugLevel is 
initially be set to this value after installing the integration. 
 
2 - The log file records the function name, file name, input parameters, output, time 
stamp, errors, warnings, and exceptions. 

Viewing the error log 

The integration automatically generates error log files. You may view the messages written 
to the error log files by viewing the files (ccmdc.log) generated in the following directories. 

C:\Documents and Settings\<username>\Application 
Data\Telelogic\vs500\ccmdc.log 

C:\Documents and Settings\<username>\Application 
Data\Telelogic\ccmdc72\ccmdc.log 

or 
<Application Data path>\Telelogic\vs500\ccmdc.log 

<Application Data path>\Telelogic\ccmdc72\ccmdc.log 

There are other error files that are generated by the integration. These error files contain 
the last known error produced by the integration. You may view the messages contained in 
these error files by viewing the files (ccmdc.err) in the following directories. 

C:\Documents and Settings\<username>\Application 
Data\Telelogic\vs500\ccmdc.err 

C:\Documents and Settings\<username>\Application 
Data\Telelogic\ccmdc72\ccmdc.err 

or 
<Application Data path>\Telelogic\vs500\ccmdc.err 

<Application Data path>\Telelogic\ccmdc72\ccmdc.err 
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Issues with this release 
The following is a list of known issues that exist in IBM Rational Synergy for Microsoft Visual 
Studio 2010 Interface 7.2.1. 

 Whenever Rational Synergy is updated to use a particular change request tool, the 
Visual Studio IDE must be restarted to show the appropriate change requests in the 
Change Request View. 

 If you create a Solution project that has the same name as the Solution, your 
Rational Synergy database must be set to support multiple project instances.  To do 
this, start an Rational Synergy session, start Synergy CLI, and type the following 
commands in the command prompt: 
 
1.)  ccm set role ccm_admin  
2.)  ccm query -t model -n base  
3.)  ccm attr -m multiple_local_proj_instances -v TRUE @1 

 Microsoft Visual Studio 2010 IDE may prompt you to: Save As, Discard, Ignore, or 
Overwrite, after a Solution/Project has been migrated. Respond to the prompt by 
selecting Overwrite. 

 Microsoft Visual Studio 2010 IDE may prompt you to Reload projects when project 
files are checked out. Respond to the prompt by selecting Reload. 

 The integration displays the Delete files prompt dialog box twice when performing 
the Exclude From Project or Delete operations on folders/directories that are 
controlled by Rational Synergy. The integration will prompt you once for the 
folder/directory and once for the files located inside the folder/directory. 

 If you have more than one instance of Microsoft Visual Studio 2010 running, all of 
the instances will share the same Rational Synergy sessions and session data.  The 
possible problems that may occur are: 
 
1.) Changing the current task for an Rational Synergy session in one instance of 
Visual Studio will overwrite the current task for that same Rational Synergy session 
in another instance of Visual Studio. 
 
2.) If you migrate projects in one instance of Visual Studio, your migrated projects 
may be lost if other projects are migrated to Rational Synergy using another instance 
of Visual Studio.  The projects that are overwritten will belong to the instance of 
Visual Studio that exits the IDE first. 
 
3.) If you modify the integration settings in one instance of Visual Studio, your 
changes will be overwritten if the integration settings are modified in another 
instance of Visual Studio.  The integration settings that are overwritten will belong to 
the instance of Visual Studio that exits the IDE first. 

 You cannot migrate Solutions and Projects with the same name if the Visual Studio 
Solutions and Projects are created in the same location as your work area template. 

 When performing a Copy Project operation, your work area template must include 
project specific information that includes the project version and project instance. 

 The integration will not allow the Undo Checkout operation to be performed on files 
that have been checked out as a result of a Rename operation. A warning message 
box opens whenever an Undo Checkout operation is attempted on such files. 
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 When performing any of the Rational Synergy team or taskbar operations by using a 
connection without a saved password, a Login dialog box opens. You can choose to 
Cancel the dialog box so that the Login dialog box does not display. However, the 
integration may not be able to perform any operation properly. You may invoke the 
Login dialog box again by selecting the Start Session menu option in the IBM 
Rational Synergy Settings dialog box or restarting the Microsoft Visual Studio 2010 
IDE. 

 If you want to modify the work area location of your Solution, you must perform the 
following steps: 
 
1.) Exit the Microsoft Visual Studio IDE. 
 
2.) Modify the work area location of your Solution by using Rational Synergy. 
 
3.) Open the Solution from the new work area location and then proceed 
adding/migrating new Projects to your Solution.  

 ASP.Net Web Application projects whose location in the file system is inside the 
directory of another Project or Solution directory can only be migrated to Rational 
Synergy as a directory when using the integration. 

 Version control operations are supported by folders/directories. However, 
folders/directories will not display symbols and tooltips. 

 In order to use the integration properly, the <IBM Rational Synergy for Microsoft 
Visual Studio 2010 Interface 7.2.1 Install Directory> directory must be included in 
your PATH. 

 Rational Synergy 7.2.1 does not allow for multiple simultaneous connections to 
different databases or servers through the API.  The Integration will allow you to 
create multiple connections but will only allow you to have one connection started at 
a time.  The Integration will automatically connect and disconnect as needed.  If you 
have more than one Synergy 7.2.1 connection defined in Microsoft Visual Studio you 
should start Synergy sessions before you start Microsoft Visual Studio for highest 
performance.  Starting the sessions before starting Microsoft Visual Studio will allow 
the Synergy sessions to remain running when the Integration disconnects, which  will 
mean  that  they  do not  need to be restarted the  next  time  Microsoft Visual 
Studio  uses the connection. 

Contacting IBM Rational Software Support 
If the self-help resources have not provided a resolution to your problem, you can contact 
IBM® Software Support. IBM Software Support provides assistance in resolving product 
issues.  
For more details about enrolling in Passport Advantage and submitting problems, see the 
“Contacting IBM Software Support” topic in the Rational Synergy information center at 
http://pic.dhe.ibm.com/infocenter/synhelp/v7m2r0/topic/com.ibm.help.common.rational.do
c/topics/t_contactingibmsoftwaresupport.html 

Notices 
© Copyright IBM Corporation 1992, 2013. 

U.S. Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA 
ADP Schedule Contract with IBM Corp. 
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This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, or 
service is not intended to state or imply that only that IBM product, program, or service 
may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's 
responsibility to evaluate and verify the operation of any non-IBM product, program, or 
service. 

IBM may have patents or pending patent applications covering subject matter described in 
this document. The furnishing of this document does not grant you any license to these 
patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing  
IBM Corporation North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 
 
For license inquiries regarding double-byte character set (DBCS) information, contact the 
IBM Intellectual Property Department in your country or send inquiries, in writing, to:  

Intellectual Property Licensing 
Legal and Intellectual Property Law 
IBM Japan, Ltd. 
19-21, Nihonbashi-Hakozakicho, Chuo-ku 
Tokyo 103-8510, Japan 
 
The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: INTERNATIONAL 
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied 
warranties in certain transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new 
editions of the publication. IBM may make improvements and/or changes in the product(s) 
and/or the program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM websites are provided for convenience only 
and do not in any manner serve as an endorsement of those websites. The materials at 
those websites are not part of the materials for this IBM product and use of those websites 
is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs and 
other programs (including this one) and (ii) the mutual use of the information which has 
been exchanged, should contact: 

Intellectual Property Dept. for Rational Software 
IBM Corporation 
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5 Technology Park Drive 
Westford, MA  01886 
U.S.A. 
 

Such information may be available, subject to appropriate terms and conditions, including in 
some cases, payment of a fee. 

The licensed program described in this document and all licensed material available for it 
are provided by IBM under terms of the IBM Customer Agreement, IBM International 
Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary significantly. 
Some measurements may have been made on development-level systems and there is no 
guarantee that these measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through extrapolation. Actual 
results may vary. Users of this document should verify the applicable data for their specific 
environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, 
their published announcements or other publicly available sources. IBM has not tested those 
products and cannot confirm the accuracy of performance, compatibility or any other claims 
related to non-IBM products. Questions on the capabilities of non-IBM products should be 
addressed to the suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. 
To illustrate them as completely as possible, the examples include the names of individuals, 
companies, brands, and products. All of these names are fictitious and any similarity to the 
names and addresses used by an actual business enterprise is entirely coincidental. 

Copyright license 
This information contains sample application programs in source language, which illustrate 
programming techniques on various operating platforms. You may copy, modify, and 
distribute these sample programs in any form without payment to IBM, for the purposes of 
developing, using, marketing or distributing application programs conforming to the 
application programming interface for the operating platform for which the sample programs 
are written. These examples have not been thoroughly tested under all conditions. IBM, 
therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. 
The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be 
liable for any damages arising out of your use of the sample programs. 

If you are viewing this information in softcopy, the photographs and color illustrations may 
not display. 

Privacy policy considerations 
IBM Software products, including software as a service solutions, (“Software Offerings”) 
may use cookies or other technologies to collect product usage information, to help improve 
the end user experience, to tailor interactions with the end user or for other purposes. In 
many cases no personally identifiable information is collected by the Software Offerings. 
Some of our Software Offerings can help enable you to collect personally identifiable 
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information. If this Software Offering uses cookies to collect personally identifiable 
information, specific information about this offering’s use of cookies is set forth below. 

Depending upon the configurations deployed, this Software Offering may use session 
cookies that collect personally identifiable information for purposes of session management, 
authentication, and enhanced user usability. These cookies can be disabled, but disabling 
them will also likely eliminate the functionality they enable. 

If the configurations deployed for this Software Offering provide you as customer the ability 
to collect personally identifiable information from end users via cookies and other 
technologies, you should seek your own legal advice about any laws applicable to such data 
collection, including any requirements for notice and consent. 

For more information about the use of various technologies, including cookies, for these 
purposes, See IBM’s Privacy Policy at http://www.ibm.com/privacy and IBM’s Online Privacy 
Statement at http://www.ibm.com/privacy/details/us/en sections entitled “Cookies, Web 
Beacons and Other Technologies” and “Software Products and Software-as-a Service”. 

Trademark acknowledgments 
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International 
Business Machines Corp., registered in many jurisdictions worldwide. Other product and 
service names might be trademarks of IBM or other companies. A current list of IBM 
trademarks is available on the web at www.ibm.com/legal/copytrade.shtml. 
 

http://www.ibm.com/privacy
http://www.ibm.com/privacy/details/us/en
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